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1  

Visualizing a Work Breakdown Structure 

Project Management involves many processes from Initiating and Planning to Closing. Whether you are managing 

a large capital project, organizing a social function, or building a deck, accurately determining how much it will 

cost, who will perform the work and when, require decomposing the project's scope of work into manageable 

units called work packages that can in turn be estimated. The best way to accomplish this is with the use of a Work 

Breakdown Structure (WBS). 

The WBS provides a means of identifying what work, in the form of deliverables, must be done, who will do it, how 

long it will take, and how much it will cost.  The WBS is the central tool that binds the whole project together.  

Decomposing project deliverables allows more accurate estimates to be made which will facilitate scheduling and 

cost tracking.  

The first official publication on the WBS was produced by the US Department of Defense in 1968, known as MIL-

STD-881C Work Breakdown Structures for Defense Materiel Items. This project management technique of 

decomposing project deliverables into smaller components has since seen widespread adoption across all 

industries. 

Various formats exist for creating a WBS. The most popular is an indented listing of project activities, with each 

indentation representing a lower level of detail. This linear approach does not convey the scope of the project as 

well as either a tabular representation or better, a graphic form. 

A graphical representation of a WBS, like that of an organization chart, is the most straightforward way to visually 

convey the scope of any project. Instead of an organizational reporting structure, each box represents a 

component of the WBS.  

This whitepaper describes an easy way to graphically create a WBS, using mind mapping software, based on the 

hierarchal examples provided in the Project Management Institute's Practice Standard for Work Breakdown 

Structures - Second Edition. Terminology used is consistent with A Guide to the Project Management Body of 

Knowledge (PMBOK® Guide) and readers are encouraged to refer to the Project Management Institute 

website https://www.pmi.org/ for definitions of terms used in this paper. 

 

 

  

https://www.pmi.org/
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2  

MindMap a WBS 

2.1 Think Deliverables 

When decomposing a project and laying out the plan, the project team begins by identifying the main project 

deliverables and milestones. These deliverables will be broken down into tasks and subtasks to produce work 

packages, which can then be estimated for costing, scheduling and resources. MindManager makes this process 

very easy, as we will see.  The examples shown use a left-handed user interface, selected under File - 

MindManager Options - General. Task panes and notes appear by default on the right. 

Start by opening a new map, then select Org Chart under Layout in the Design menu. Name your project using the 

central topic and begin identifying the project deliverables: 

 

 

For each deliverable identified for the project, ask your team, “In order to produce this, what is the next smallest 

step that must be taken?" For example, if you are preparing a corporate function, your deliverables would be the 

dinner, hiring staff, the room and equipment, the guest list, speakers, etc. To provide the dinner, you need to 

create a menu, make a shopping list, buy the food, cook it and finally serve the meal. Keep note of the dependent 

tasks. An example of a Corporate Function WBS is provided below. 
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One pitfall to avoid is taking the decomposition exercise too far. The goal is to stop decomposing when you have 

sufficient granularity to be able to confidently estimate duration and cost of the work package. A rule of thumb 

known as the 8/80 rule suggests limiting each work package to between eight and eighty hours of effort. A Guide 

to the Project Management Body of Knowledge (PMBOK Guide) Sixth Edition recommends a generic model as an 

excellent starting point. Each project is unique and the generic model is only a guideline, so be flexible in your 

approach and let the complexity of the project determine the required number of levels of decomposition. Don't 

plan in more detail than you can manage. 

2.2 Entering Task Information 

The goal of an effective schedule is to minimize the time taken to complete a project by finding ways to parallel as 

many activities as possible.  Once the WBS is created in MindManager, we can proceed to provide the building 

blocks for a project schedule.  First, we will enter basic task information about when the work will be completed, 

and how much effort will be involved over the period.  Then we will assign resources, identify task dependencies, 

and roll up the task information to produce a schedule. 

2.2.1 Duration & Effort 

Using the Task Info tab, select the WBS element of interest and fill in the relevant information.  First, enter Start 

and End Dates, as well as the level of effort for the work package. MindManager also includes an 'Effort' field that 

can account for the actual time it is estimated to take to complete the task. This is important when the same 

resource is required for multiple tasks that are to be completed in parallel, or if the resource is working on multiple 

projects. 
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2.2.2 Resources 

To assign resources to individual work packages, first create a resource table. Either select the Resources drop-

down under the Task menu or click on the Resources tab on the task pane. Then click Manage Resources. 

 

Then a table will appear in which you can list the resources, by name or position, who will work on the project. 
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Adjust the availability of each resource during the work week under the availability column. Then select the 

resource(s) from the Resources field in the Task Info pane. 

 

2.2.3 Dependencies 

MindManager allows you to quickly and easily enter dependencies for tasks and components within the WBS. The 

standard logical dependencies are included, for example specifying that a successor task cannot start until its 

predecessor is completed. In the image below, all Plan and Supervise work packages have been selected and the 

Finish to Start dependency has been applied to the successor tasks. If a date is set for Create Plan work package 

(the predecessor task) of 5 February 2018, the successor tasks will have dates automatically assigned to them, 

which can later be adjusted. 

 

 Select the dependent tasks. Click Finish to Start Dates are automatically populated according to the defined 
dependencies. 
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2.2.4 Rolling-Up Task Info 

Once all the work packages have task information entered, you are ready to Roll up the task information at either 

the sub-task level or for the entire project. Select any deliverable that has work package task information and 

check the Roll up Task Info box. Doing so will cause the Gantt chart, see section 2.5 below, to display the 

components in an indented format. 

 

  

2.3 WBS Numbering 

Every component of a WBS is assigned a unique number known as a WBS code so that work can be identified and 

tracked over time. A WBS may have varying numbers of decomposition levels, but there is a general scheme for 

how to number each level so that tasks are uniquely numbered and correctly summarized.   

One standard convention for how tasks are decomposed is as follows:  

 Level 1 – Designated by 1.0.  This level is the top level of the WBS and is usually the project name.  All other 
levels are subordinate to this level. 

 Level 2 – Designated by 1.X (e.g., 1.1, 1.2).  This level is the summary level. 

 Level 3 – Designated by 1.X.X (e.g., 1.1.1, 1.1.2).  This third level comprises the sub-components to each level 2 
summary element.   This effort continues down until progressively subordinate levels are assigned for all work 
required for the entire project. 

If tasks are properly subordinated, most project scheduling tools will automatically number tasks using the above 

convention. 
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MindManager makes numbering elements of a WBS very easy, its default numbering scheme looks like this: 

 

To create WBS codes using the PMI numbering scheme, open a new map and give the Central Topic a name (e.g. 

‘WBS’), making sure to select the Org Chart layout for the new central topic. Then add a new topic under the 

Central Topic (e.g. ‘Corporate Function’). Now, number the map as follows: 

Select topic ‘Corporate Function’. Then select Numbering Options under the Insert menu - Topic Elements - 

Numbering list. 

 

Then choose the number of levels of decomposition under the Depth drop-down list, leaving all defaults the same. 
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The result will be a WBS map with a standard PMI numbering scheme like this: 

 

WBS Standard numbering scheme. Dependent tasks (dependencies hidden) are denoted with a symbol . 

 

2.4 WBS Dictionary 

A WBS dictionary provides a description of what is included in a WBS element. Neglecting to create a WBS 

dictionary can cause problems that can ultimately threaten project success.  An example would be a recurring 

project that has several hundred WBS elements, none of which are defined beyond the three or four words in the 

element's name.  

Staff turnover can result in the meaning of many of the tasks in a recurring project getting lost in the shuffle.  A 

WBS dictionary will help prevent this from happening. 

MindManager allows the user to create a WBS Dictiionary 'on the fly'. Select a WBS element and click 'Notes' 

under the Insert menu.   

 

A Topic Notes window will appear next to the map area, and here we provide a description of the WBS 

component. Text notes can be created in a structured fashion with standard formatting features. 
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All that is required is to attach a similar Topic Note with a short description into each WBS element and voilà! the 

WBS dictionary is almost ready to be produced.  What you should also do is add numbering to each component in 

the WBS. To create a WBS Dictionary, select Export under the File menu and click on Microsoft Word. 

 

The output will be a nicely formatted MS Word document, with numbered paragraphs corresponding to the 

unique WBS codes for each component of the WBS, along with the short descriptions entered in the Topic Notes. 

2.5 Gantt Charts 

MindManager 2018 comes with a built-in core Gantt charting capability. Once the WBS components have been 

given start and due date information and dependencies, select the Gantt chart icon at the bottom of the mind map 

window to view tasks on a Gantt timeline. 
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The result will be a Gantt chart that can be displayed either above, below, to the left or to the right of the WBS 

map. In the image below, the Gantt chart, with critical tasks highlighted in red, is displayed to the right of the map: 

 

Core Gantt 

The Enterprise version of MindManager 2018 has several enhancements, including Gantt Pro. It offers more 

features than the core Gantt and can be opened in a new window for display on a separate monitor. 

 

Gantt Pro 

It is also possible make adjustments to the task information directly within the Gantt chart, and to have 

MindManager display the Critical Path (and critical tasks) for the project. The Critical Path is defined as the longest 

sequence of activities in a project plan which must be completed on time for the project to complete on the due 

date.  
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2.6 Tracking and Reporting Status 

There are several of ways that tasks can be tracked and reported using MindManager. When making updates to 

the schedule, indicate the completeness status of all active tasks to enable reporting tasks that are late or at risk of 

missing deadlines. 

  

Filtered reports can also be produced by task date, priority, and resources. In the example Corporate Function 

project below, only those tasks assigned to the resource Admin Assistant are displayed. This is useful when several 

teams of resources are involved in a project and require individual work plans. 

  



 14 

2.7 Pitfalls to Avoid 

As mentioned above, avoid taking the decomposition of WBS elements too far, and turning the WBS into a to-do 

list or a step-by-step procedure for doing everything. This leads to micro-management, which is not generally 

attractive to team members, and is not the purpose of the WBS.  Limit the decomposition to what you can 

reasonably manage. As a general rule, WBS tasks should have durations between 8 hours and 80 hours. 

Other pitfalls include: 

 Not Getting Buy-in from the Team 

The WBS should be drafted with input from all team members, especially subject matter experts. If the project 

manager creates the WBS with limited input from other project team members, they may in turn offer little to no 

support for the final product. It may be time-consuming, but in the long run it pays to engage all of the core project 

leaders in the WBS development. 

 Skipping the WBS Dictionary 

It may be tempting to think you do not require a WBS Dictionary since the WBS and schedule are self-explanatory. 

But it may not be so clear to a new team member or worse, a new project manager who may inherit the project 

mid-way through execution.  If you take some time to enter basic descriptions for each component of the WBS in 

Topic Notes, the WBS Dictionary will essentially be complete and ready to share. 

  Neglecting Formal Change Control 

Any update to a WBS, other than clarifying details that already exist, should require formal change control. To 

ignore this step invites scope creep that can spell doom for the project. 

 Adding Requirements in Lieu of Tasks 

When you place a deliverable on your WBS, you can break down the deliverable into the activities required to 

create it. What doesn’t work is breaking down the deliverable into the requirements that describe it. Deliverables 

and tasks do belong in the WBS, but requirements do not.  

2.8 Sharing & Publishing 

You can share your WBS mind map with anyone, even if they do not have MindManager. A popular format for 

sharing a mind map is in HTML5 format which will allow the recipient to navigate through the document with their 

browser. You may also convert your WBS mind map to MS project, or synchronize tasks with SharePoint to 

facilitate collaboration on tasks within a team.   
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3  

Conclusion 

There are many reasons why projects can, and do, fail. The International Project Leadership Academy lists 101 

common causes of project failure, chief among them being organizational dysfunction and poor planning.  How 

effectively a project team creates a WBS can determine the success or failure of a project.  A well thought-out WBS 

is the source of a sound project schedule.  

Creating a WBS is critical in the planning stages of any project. It is the central tool that binds an entire project 

together and supports so many of the areas of project management. To ensure a comprehensive WBS, make sure 

to include team members and subject matter experts in brainstorming sessions to define the work required to 

successfully deliver the project scope. 

However you approach the creation of a WBS, the benefits of doing so will outweigh the effort required.  What 

was once an arduous task is made not only easy, but enjoyable when undertaken with modern mind mapping 

software packages like MindManager. 
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